
Reform To Ricoh LANFax 

 

9/7/2011 
 
 
 
 
 
 

 
 
 

 
 
 
 

 

LANFax 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Reform To Ricoh LANFax  2 
 

 

 

Índice 

Sobre el Plugin Ricoh LANFax.............................................................................................. 3 

Requisitos del Sistema ........................................................................................................ 3 

Requisitos del Hardware ..................................................................................................... 3 

Controladores Soportados .................................................................................................. 4 

Instalación ........................................................................................................................... 4 

Registro y Licencia del Plugin .............................................................................................. 5 

Configuración del primer formulario Ricoh LANFax-Habilitado ......................................... 7 

Monitoreando el Estado del Fax desde el Device Viewer ................................................ 22 

Recomendación para mejorar el Rendimiento ................................................................. 24 

Configuración Archivo Adjunto ......................................................................................... 24 

Portada de Fax .................................................................................................................. 25 

Servicio Ricoh Fax .............................................................................................................. 25 

Mantenimiento ................................................................................................................. 26 

Instalando/Configurando Internet Information Services (IIS) 2003 ................................. 27 

Configuring Internet Information Services (IIS) 7 ............................................................. 33 

Solución de Problemas ...................................................................................................... 36 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Reform To Ricoh LANFax  3 
 

 

 

Sobre el Plugin Ricoh LANFax  
El Plug-in de Ricoh LANFax permitirá a Reform 12 interactuar con un Periférico Multi 
Función LANFax-habilitado para distribuir automáticamente los documentos en el 
sistema de fax. 
 

Requisitos del Sistema 
 Reform 12 Enterprise o Reform 12 PDC 

 Plugin Ricoh LANFax Plugin 

 Para evaluación y demostración: Windows XP, Windows 2003 Server, Windows 
Vista, Windows 7 o Windows Server 2008 (se admiten los sistemas operativos de 64 
bits) 

 Para los sistemas de producción: Windows Server 2003 o Windows Server 2008 
(sistemas operativos de 64 bits son compatibles) 

 Smart Device Monitor (incluido con instalacion) 

Periférico Multi Función LANFax-habilitado (Controladores sostenidos listados a continuación) 

 Microsoft SQL Server (SQL Server Express serra instalado automaticamente) 

 Microsoft .NET Framework 3.5 (instalado automaticamente si no esta ya 
presente en el sistema) 

 Internet Information Services (IIS) 

 

Todas las descargas de software Reform necesario pueden encontrarse en 
www.fabsoft.com >> Sección de descargas. 

 

Requisitos del Hardware  
 Recomendación de Producción del Sistema (Estas sugerencias son sólo 

estimados. Entornos de alta carga pueden requerir varios servidores o 

hardware adicional.) 

1. Procesador Pentium 4 

2. 4 GB de RAM 

3. Espacio HDD de 100 GB (Redundancia Recomendada) 

4. Batería de Reserva (UPS) 

5. Servidor dedicado, no hay productos de software, excepto los 

programas de antivirus y de seguridad. 

 Requisitos mínimos del sistema para fines de demostración 

1. Procesador Pentium 4 

2. 2 GB de RAM 

3. Espacio HDD de 30 GB 

 

http://www.fabsoft.com/
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Especificaciones de hardware dependen enormemente de la carga de trabajo y el 
rendimiento que se requiere. Procesadores de gama superiores y una mayor cantidad 
de memoria aumentará la cantidad de información y datos que Reform puede procesar, 
mejorando el rendimiento general del sistema. Para equilibrio de carga y failover, 
también pueden utilizar varios servidores. (Nota: se requiere una licencia para Reform y 
cada Plug-in para cada Servidor que ejecuta el software.) Antes de obtener el servidor 
que desea utilizar para Reform, por favor revisar  los manuales de usuario de los plug-ins 
para requisitos del sistema, así como pueden requerir hardware adicional. Para sistemas 
de producción, se recomiendan también discos duros redundantes utilizando las 
características espejadas de RAID (matriz redundante de independiente discos) para 
minimizar la pérdida de datos y acelerar la recuperación del sistema en caso de una falla 
de hardware. También se sugieren respaldos de batería para mantener la disponibilidad 
del sistema y fiabilidad en caso de apagones 

Controladores Soportados 

 RICOH LAN-Fax M3 y mayores que se ha conectado a la Red de área Local 

 RICOH LAN-Fax F3 y mayores que se ha conectado a la Red de área Local 
 

Instalación 
Para instalar el Plug-in Ricoh LANFax a su instalación existente de Reform 12, descargue 
y ejecute el archivo ejecutable de instalación de Ricoh LANFax. Antes de comenzar la 
instalación, es importante tener en cuenta que ya debe tener un dispositivo de Ricoh 
con un controlador de LANFax compatible instalado y funcionando en este equipo. 
 
Si está ejecutando Reform en un Servidor Windows 2003, consulte la sección Instalar 
Internet Information Services (IIS) 2003 de este manual antes de continuar. 
 
Si está ejecutando Reform en Windows Vista, Windows 7 o un Servidor Windows 2008, 
consulte la seccion Configurando Internet Information Services (IIS) 7 de este manual 
antes de continuar. 
 
Si cumple todos los requisitos, ejecutar el archivo ejecutable. 
 

 
Siga paso a paso a través de los mensajes hasta que hasta que comience el programa de 
instalación. Permita que la instalación LANFax se complete. 
 
El directorio de instalación predeterminado para Reform 12 y sus plugins es C:\Program 
Files\Reform…\.  Si ha cambiado la ruta durante la rutina de instalación Reform, o si 
utiliza un sistema operativo de 64 bits, consulte la ruta adecuada en lugar del 
predeterminado al que hace referencia a lo largo de esta documentación.   
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Registro y Licencia del Plugin 
Al evaluar Reform 12, los plug-ins también estarán en un modo de evaluación para ese 
período de tiempo. Una vez que Reform ha sido comprado y con licencia, se debe poner 
licencia a los plug-ins usados para continuar funcionando correctamente.    
  
Consulte la sección "Reforma 12 licencias y registro" del Manual de Usuario Reform para 
más información acerca de cómo dar licencias a los Plug-ins de Reform 12.  Después de 
introducir la licencia, el Reform Spooler se tendrá que reiniciar para actualizar las 
licencias. Puede encontrar más información sobre el servicio Reform Spooler en el 
Manual de usuario de Reform 12. 
 
 

Prueba de conexión y SmartDevice Monitor 
A continuación, tenemos que ejecutar las pruebas de conexión e instalar algún software 
adicional.  
 
Ejecutar al cliente de Fax de Ricoh yendo a: 

Start>Programs>Reform…>LAN-Fax>Check Fax System 
 

Lo primero que tenemos que hacer es asegurarnos de que está instalado el SmartDevice 
Monitor. Haga click en la pestaña SmartDevice Monitor Installation. Si se le indica que 
debe instalarse el Monitor, haga click en el botón Launch Client Setup para ejecutar al 
instalador para el SmartDevice Monitor.  
 

 
 

El instalador de SmartDevice Monitor es sencillo a recorrer. Mantenga la configuración 
predeterminada para una instalación completa, pero en la pantalla siguiente, asegúrese 
de activar la opción para ejecutar el SmartDevice Monitor de cliente al iniciar 
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Permitir que el programa de instalación instalar el SmartDevice Monitor. Después de 
que termine de instalar, reinicie el equipo para completar la instalación. Si ya se ha 
instalado el SmartDeviceMonitor, sigue siendo importante reiniciar el equipo antes de 
proceder  a fin de asegurar que el servicio RicohFax se inicie. 
 
Una vez reiniciado el equipo, abra al cliente de Fax de Ricoh. Haga click en la pestaña 
SmartDevice Monitor Installation. Ahora debe decir que está instalado el SmartDevice 
Monitor. 
 

 
 

Ahora está listo para realizar una prueba de conexión. Haga click en la pestaña 
Connection Test, y siga paso a paso a través de cada prueba. 

1. Chequea  para asegurarse que el Plug-in Ricoh LANFax está registrado 
correctamente. 

2. Cheque la compatibilidad entre LANFax API y el Plug-in Ricoh Fax. 
3. Busca todas las impresoras disponibles LANFax-habilitado. 
4. Cheque la disponibilidad de componentes de impresión de PDF. 
5. Se asegura que el SmartDevice Monitor está instalado. 
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Después de que hayan superado las 5 pruebas de conexión, está listo para incorporar el 
primer formulario LANFax.  
 
Diríjase a la siguiente sección: “Configuración del primer formulario Ricoh LANFax-
Habilitado.” 

 

Configuración del primer formulario Ricoh LANFax-Habilitado  
Este tutorial le guiará a través de los pasos de configuración de un formulario para 
enviar un fax con una impresora LANFax-habilitada. 
 

En primer lugar, debe iniciarse el Reform Designer.  Para abrirlo, ir a Start> Programs> 

Reform…>Designer. 

1. Para el ejemplo, estamos creando un nuevo formulario con una plantilla existente. Ir 
a File>New>New. Seleccione la plantilla Fax y haga click en OK. 

 
2. Cuando le pregunta si desea abrir un archivo de texto para el diseñar, seleccione No. 

 
3. Después, ir a File>Save para guardar su formulario. Llámelo Fax.FOM. 
 
4. Ahora puede cerrar el Reform Designer ya que tenemos nuestro formulario que va a 

ser utilizado junto con el Workflow Designer para distribuir el documento. 

 

* Ahora que tenemos nuestro formulario, podemos empezar a crear el flujo de trabajo 

Ricoh LANFAX usando Workflow Designer.  En primer lugar, debe iniciarse el Workflow 

Designer.   
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Para abrirlo, ir a Start>Programs>Reform… >Workflow Designer. 

5. Una vez abierto, debemos ir a File > New… 

 

6. Seleccionar “Document Automation” y haga click en Ok. 

 
 

7. Ahora verá que sus entradas, procesos y salidas han sido pobladas por varios plug-

ins que han sido instalados (RicohFax siendo uno de los procesos) 
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8. Podemos empezar a agregar los componentes necesarios para el flujo de trabajo. 

En primer lugar, arrastrar y soltar un objeto Form and File en el flujo de trabajo 

haciendo click y sosteniendo el mouse en Form and File, a continuación, mover el 

mouse sobre el flujo de trabajo y soltar el botón del mouse.  

 

 
 

* Aparecerá el siguiente cuadro de diálogo: 
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9. Escriba una descripción para el objeto que acaba de agregar. Para ello, escriba en el 

cuadro proporcionado. Escriba “RicohFax Demo” y haga click en Finish. Esto le 

llevará de regreso a su flujo de trabajo. 

10. Ahora estamos listos para configurar el formulario de “RicohFax Demo” y el 

archivo de entrada.  Para ello, haga click derecho en el objeto recién agregado y 

seleccione  “Configuration…” o simplemente haga doble click en el. 

 
 

11. Ahora aparecerá la ventana Configuración de entrada.  En primer lugar, queremos 
que seleccione la secuencia de datos o archivo de texto que va a utilizar nuestro 
formulario.  Para ello, simplemente puede empezar a escribir en el cuadro o puede 
navegar hasta encontrarlo.  Queremos que seleccione el archivo Fax.out.  Haga 
click en el icono de carpeta pequeña para abrir una ventana que nos permite 
escoger ese archivo.  Seleccione el archivo y haga click en Open. 
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12. Después de seleccionar el archivo de texto, volverá a la página de configuración de 
entrada para que ahora puede seleccionar un formulario.  Haga click en el icono de 
carpeta pequeña para abrir una ventana que nos permite escoger el archivo 
deseado, el formulario Fax.FOM Seleccione el archivo y haga click en Open.  

 

 
 

13. Ahora que tiene el archivo de texto de entrada y la reforma de formulario 
seleccionado, la instalación de “Form and File” está completa.  Puede comprobar 
rápidamente que los archivos correctos fueron seleccionados y, a continuación, 
haga click en Finish.  

 

 
 

14. También se pedirá que agregar un campo de salto de página a los formularios. En 
este punto, queremos seleccionar No. 

 

15. Para finalizar el flujo de trabajo Fax, queremos agregar un proceso RicohFax.  
Usamos el mismo proceso arrastrar y colocar como con el “Form and File” (ver 
paso 9).  Tomar el mouse y arrastre el objeto “RicohFax” bajo proceso de flujo de 
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trabajo en algún lugar debajo de la entrada. Una vez que suelte el mouse, se le 
pedirá que describa “RicohFax”.  Escriba “Ricoh LANFAX” i en el cuadro y haga click 
en Finish. 

 

 

16. Una vez que haga click en finalizar, volverá a su flujo de trabajo.  RicohFax tendrá 
un título Rojo porque no se ha configurado aun. Para configurar RicohFax, primero 
debe conectar el objeto Form and File llamado “RicohFax Demo”.  Para ello, 
seleccione primero el botón “Add Connector” de la barra de menús. A 
continuación, arrastre el mouse de la pequeña “x” debajo de “RicohFax Demo” 
hacia la pequeña “x” encima de “Ricoh LANFAX” como muestra la imagen a 
continuación. Cuando se completa la conexión, el conector se volverá negro (si es 
roja, la conexión no se ha realizado correctamente, inténtelo de nuevo) y el título 
de “RicohFax  Demo” cambiará a verde. 

 
17. Deberá configurar RicohFax al finalizar la conexión.  Haga click en Yes.   Si hace click 

en No, también puede hacer doble click en el objeto RicohFax o click derecho y 
seleccionar “Configuration…” Esta configuración le guiará a través de todos los 
ajustes necesarios para  RicohFax para conectarse a su controlador Ricoh LanFax y 
mandar faxes.  La primera pieza de información es Username. Este nombre de 
usuario debe ser el nombre con el cual está actualmente conectado. Esto le 
permitirá ver los estados de fax en el Device Viewer. Escriba su nombre de usuario y 
haga click en Next. 
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18. El siguiente mensaje es “Sender’s Company Name”.  Aquí nos gustaría utilizar 
datos que están disponibles en la secuencia de datos en lugar de un valor estático. 
Para ello, primero debemos pulsar el botón  “Click here to select variable 
information”.  

 
* Nota-Después de hacerlo, vemos que aparece una lista con los diferentes campos que 
puede elegir para los datos variables.  Si desea volver a modo de entrada estático, 
puede hacerlo haciendo click en el botón adecuado para información estática y, a 
continuación, podrá escribir información estática. 
 

19. Queremos utilizar el campo dinámico ShipToName como el “Sender’s Company 
Name”. Seleccione ShipToName en la lista (tendrá que desplazarse hacia abajo) y 
haga click en Next. 
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20. Para “Sender’s Name”, nos gustaría volver a utilizar datos variables de la secuencia 

de impresión.  Para ello, primero haga click en el botón “Click here to select variable 

data”.  En la lista que aparece, seleccione ClientName y haga click en Next. 

 

 
 

21. El siguiente mensaje le preguntará el Department Name de la persona que envía el 

fax. Escriba el valor Accounting, y haga click en Next. 
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22. A continuación, le solicitará que introduzca el Número de Teléfono (no el número de 

fax!) de la persona que envía el fax. Introduzca el valor 973-555-0123, y haga click en 

Next. 

 

 
 

23. A continuación, le solicitará que introduzca el Número de Fax de la persona que 

envía el fax. Introduzca el valor 201-555-1234, y haga click en Next. 
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24. Para “Recipient’s Company”, nos gustaría utilizar datos variables de la secuencia de 

impresión. Para ello, primero haga click en el botón “Click here to select variable 

data”.  En la lista que aparece, seleccione ShipToName (desplácese hacia abajo) y 

haga click en Next. 

 

 
 

25. Para “Recipient’s Contact Name”, nos gustaría volver a utilizar datos variables de la 

secuencia de impresión. Para ello, primero haga click en el botón “Click here to 
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select variable data”.  En la lista que aparece, seleccione ClientName y haga click en 

Next. 

 

 
 

26. A continuación, le solicitará que introduzca el nombre de departamento de la 
persona que recibe el fax. Escriba el valor ShippingReceiving, y haga click en Next. 
 

 
 

27. Para “Note / Memo”, nos gustaría utilizar datos variables de la secuencia de 

impresión. Para ello, primero haga click en el botón “Click here to select variable 

data”.  En la lista que aparece, seleccione la descripción y haga click en Next. 
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28. A continuación, escriba el Número de Fax del Destinatario para el equipo que desea 
enviar el fax. Este número es donde se enviará el fax.  

*POR FAVOR, ASEGURESE DE QUE ESTE NUMERO PUEDE RECIBIR FAXES 
CORRECTAMENTE!* 

 

 
 

29. El asistente le pedirá ahora para el tipo de línea de la MFP. Seleccione el tipo de 
línea para el Fax (el valor predeterminado es G3) y haga click en Next. 
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30. Por último, el asistente ahora recopilará información sobre el controlador de LANFax que desea utilizar. 

Seleccione el controlador LAN Fax a utilizar y haga click en Finish. 
 

 
 

31. Ha completado la configuración del flujo de trabajo RicohFax.  Sus 2 objetos 
(“RicohFax Demo” y “Ricoh LANFAX”) ambos deben ser verde lo cual significa que 
se han configurado correctamente y está listo para crear el flujo de trabajo. 
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32. Para hacer todos los formularios y cambios adecuados, se debe ejecutar el flujo de 

trabajo.  Para ello, haga click en el botón “Ejecutar”  en la barra de 
menús. Después de la ejecución, se le notificará acerca de lo que ha llevado a cabo. 
Haga click en OK. 

 

 
 

33. Ahora puede cerrar el Workflow Designer. El formulario se ha guardado en el 
directorio de formulario predeterminado.  Un respaldo de su archivo original 
Fax.FOM ha sido copiado a su carpeta “Workflow Designer Original Forms” en su 
directorio de formularios.  Se efectuarán los cambios de forma permanente a su 
formulario original ya que se utiliza en todo el proceso de configuración de 
formulario como una plantilla.  Si se realizan cambios en esta plantilla, tendrá 
que ejecutar el flujo de trabajo para ver los cambios en los formularios. 

 

34. El Spooler debe comenzar ahora haciendo click en Start> Programs> Reform…> 
Spooler.  Una vez abierto, pulse el botón Inicio.  Ahora debería decir Start en la 
esquina inferior izquierda. 

a. Si ya se estaba ejecutando, tendrá que detener y reiniciar para que 

reconozca los nuevos formularios que fueron creadas por el Workflow 

Designer. 
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35. Navegue a su directorio \Reform\Backups\. Seleccione el archivo Fax.out, haga click 

derecho en el archivo, y seleccione Copy. 

 
 

36. Navegue a su directorio \Reform\Spooler\. Pegue el archivo en el directorio 

Spooler. (Pegar la secuencia de datos para esta carpeta simula la impresión desde 

Windows, AS400, Unix, etc.) 
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37. Cuando la aplicación Spooler comienza a procesar el archivo, se dará cuenta de que 
el nombre de archivo cambia a algo parecido a la imagen de abajo. 
 

 
 

38. Una vez que el documento es enviado por fax, la demostración esta completa.  Si no 

obtiene su proceso, Reform Spooler puede que no tiene los permisos correctos para 

procesar el archivo.  Consulte el manual de Reform 12 para obtener más 

información.  Puede reimprimir el documento copiando el archivo desde el 

directorio de respaldo al directorio Spooler.  También puede crear otro nuevo 

formulario utilizando el Workflow Designer. 

También puede ver el estado del trabajo LANFax abriendo el Device Viewer. Esto se ve 

en la siguiente sección. 

Monitoreando el Estado del Fax desde el Device Viewer  
El Device Viewer es un sistema de vigilancia basado en web empaquetado con el 
complemento de LANFax de Ricoh que permite ver el estado de diferentes trabajos 
enviados a través de Reform (Microsoft NET Framework 3.5 es necesario para usar el 
Device Viewer). Mediante el uso de  Device Viewer, se puede ver los cambios de estado 
cada minuto en una interfaz fácil de usar. 
Puede abrir el Device Viewer yendo a: 

Start>Programs>Reform…>LAN-Fax>Fax Web Client 
 

 
 

Verá una pantalla de inicio de sesión (en la foto superior). Device Viewer 
automáticamente obtiene su nombre de usuario de Windows con el cual está 
actualmente conectado y permite iniciar sesión con ese nombre. Para acceder, 
simplemente pulsa el botón de Login. Después de iniciar sesión, verá el panel principal 
Device Viewer. 
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Notará 3 pestañas distintas en la parte superior del área del estado principal: Successful, 
Pending, y Failed. Puede cambiar entre estas 3 pestañas para ver el estado de cualquier 
proceso enviado a LANFax.  De forma predeterminada, sólo verá faxes enviados desde 
su nombre de usuario. 
 
Personalización de vistas 
Puede personalizar las columnas que se mostrarán en los paneles de estado mediante la 
ampliación de la lista de opciones de visualización en el lado derecho de la página. Esta 
lista contiene todas las columnas posibles que se pueden mostrar. 
Predeterminadamente, son todos seleccionados y visibles. Anule la selección de 
columnas que no desea que aparezca en el panel de Estado. 

 
Administrando trabajos fallidos LANFax 
Trabajos que se encuentran en la pestaña Failed no pudieron ser enviados 
correctamente. Esto puede ser causado por una multitud de problemas. Sin embargo, 
estos trabajos se pueden editar y reenviados nuevamente. 
 

 
 
Una vez en la pestaña Failed, verá las entradas para cada trabajo fallido. A la izquierda 
de cada trabajo se verá 3 Enlaces: Preview, Delete, y Edit. 
 
Preview – Esto permite descargar una copia del documento que ha fallado. 
Delete – Elimina completamente el trabajo de la base de datos. Esto es irreversible. 
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Edit – Esto permite editar cada campo para corregir cualquier problema que haya 
podido causar el fax a fallar. Después de modificar el campo o campos, puede volver a 
intentar mandar el trabajo para que LANFax pueda intentar procesarlo otra vez. 
 

 
 
Después de que han cambiado los campos apropiados, haga click en el enlace Resend en 
el lado izquierdo. La página se actualizará y el elemento que acaba de modificar se 
moverá a la página Pending hasta que esté listo para ser procesado.  
 

Recomendación para mejorar el Rendimiento  
Si deshabilita los informes de resultados de comunicación en el MFP, puede evitar 
retrasos en las actualizaciones de estado de fax. La función de informe de resultado de 
comunicación puede provocar estos retrasos si el MFP tiene una bandeja abierta, es de 
papel o por cualquier otra razón no es capaz de imprimir el informe.  
 
Para deshabilitar los informes de resultados de comunicación en el MFP, siga estos 
pasos: 

1. Desde los controles MFP, pulse el botón User Tools. 
2. Desde la pantalla MFP, seleccione Facsimile Features. 
3. Seleccione la pestaña Administrator Tools de la ventana MFP. (pestaña Initial 

Settings en MFPs más recientes). 
4. Haga click en el botón Next en la pantalla MFP en la esquina inferior derecha de 

la pantalla para pasar a la segunda página de opciones de administración. 
5. Seleccionar el botón Parameter Settings en la pantalla del MFP. 
6. Seleccionar el botón 03 en la pantalla del MFP. 
7. Desactive el botón 0 que debe aparecer al ser presionado y mostrar un valor de 1 

por encima de él. Después de anular la selección del botón, su valor actual debe 
ser 0. 

8. Seleccione el botón OK en la pantalla del MFP y a continuación seleccione el 
botón Exit en las pantallas anteriores hasta volver a la pantalla que desee. 

 

Configuración Archivo Adjunto  
Para configurar Reform para usar archivos adjuntos con Ricoh LANFax, haga click en el 
botón Attachment Setup al lado de la lista desplegable Transport Type en Configuración 
de Pagina para abrir el cuadro de diálogo Attachment Setup.  

Nota: El Plug-in Ricoh LANFax sólo admite archivos adjuntos en PDF.  El Workflow 
Designer se configura automáticamente para usted. 
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Portada de Fax  
Para utilizar la página de portada de LANFax en los faxes, seleccione Fax Cover Page 
bajo el submenú Automation del menú Options como de costumbre. En lugar de buscar 
una portada, escriba el nombre de portada de fax que existe en el sistema de LANFax. 
Para utilizar la portada predeterminada LANFax, escriba ‘System Default’ en el cuadro 
archivo de portada. 
 
Para ver una lista de portadas disponibles o crear otros nuevos, abra el editor de la 
página de portada de LanFax yendo a Start>LanFax-Utilities>Lan Fax Cover Sheet 
Editor. 
 

Servicio Ricoh Fax 
Un único servicio se instala con el plugin de Ricoh LANFAX.  La finalidad de este servicio 
es para comunicarse con el dispositivo de Fax instalado. Al configurar el formulario de 
fax habilitado, tienes que configurar el tipo de línea y el controlador para su sistema de 
fax. Cuando se imprimen los datos a ese formulario, envía el documento, el tipo de línea 
y el controlador hasta la base de datos SQL. Este servicio controla las entradas en la 
base de datos para retransmitirlas al dispositivo de fax real.  Esto permite realizar un 
seguimiento de documentos, así como la corrección de errores y el control. Si cambia 
los controladores LANFax, este servicio debe reiniciarse. 
 
El servicio está instalado durante la instalación del plugin de Ricoh LANFAX. Después de 
la instalación, se solicitará que reinicie el equipo para que este servicio se puede iniciar. 
El servicio Ricoh Fax debe ser establecido en automático y se debe iniciar después de 
reiniciar. Para ver los servicios instalados, vaya a Start>Control Panel>Administrative 
Tools > Services. 
 

 
 

Se recomienda ejecutar el servicio como una cuenta de dominio con privilegios 
administrativos en el equipo local. Para ello, haga click con el botón derecho en el 
servicio y vaya a Properties. A continuación, haga click en la pestaña Log On.  Utilice la 
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opción “This Account” para acceder a la cuenta de servicio deseado. Haga click en OK 
cuando haya terminado.  El servicio puede que tenga que reiniciar para que los cambios 
surtan efecto. 

 
 

Mantenimiento 
Hay ciertos directorios y tablas SQL que deben controlarse para crecimiento, junto con 
el plugin Email para Reform 12.  Cada vez que un sistema procesa más y más trabajos, el 
tamaño de estos directorios y tablas SQL puede crecer muy rápidamente. En general el 
rendimiento del sistema puede verse afectado por la gran cantidad de espacio que 
pueden ocupar los archivos.  Además, existe un límite de base de datos de 4 GB si utiliza 
Microsoft SQL Server Express 2005 suministrado con la instalación. Entradas obsoletas 
archivos/base de datos se deben eliminar de acuerdo a sus necesidades y 
especificaciones de retención de archivos. Se recomienda monitorear el crecimiento de 
los siguientes directorios y tablas SQL. 
 
Directorios: 
C:\Program Files\Reform…\Backups 
C:\Program Files\Reform…\Spooler\ImageQueue 
C:\Program Files\Reform…\Plugins\DeviceViewer\FaxJobs\ 
 
Tablas SQL: 
LanFaxPhoneBook 
RicohFaxTrans 
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Otros nombres de empresas o productos mencionados en este documento pueden ser 
marcas comerciales o marcas registradas de sus respectivas empresas 

Instalando/Configurando Internet Information Services (IIS) 2003 
Internet Information Services es necesario para operar el Document Authority Control. 
Esta sección le guiará a través de cómo instalar IIS 2003, así como la configuración de la 
instalación para garantizar el funcionamiento correcto de DAC. Esta instalación requiere 
Windows 2003 Service Pack 2 CD/DVD. 
 
Ir a Start>Control Panel>Add/Remove Programs. 
 

 
 

En Add/Remove Programs, haga click en el botón Add/Remove Windows Components. 
 

 
 

Verá una lista de componentes de Windows que puede instalar. Para buscar Internet 
Information Services, haga click en Application Server, luego haga click en el botón 
Details. 
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Otra ventana aparecerá con varios componentes, que puede instalar. Tenemos que 
instalar Internet Information Services, así que marque la entrada para IIS. Observará 
que se seleccionará la red habilitar acceso COM +, esto es normal. Haga click en el botón 
OK. 

 

 
 

Haga click en el botón Next para comenzar el proceso de instalación. 
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Ahora comenzará la instalación. Después de algunos segundos, aparecerá una ventana 
que le pedirá que elija la ubicación de los archivos en el CD/DVD. Haga click en el botón 
Examinar para abrir un diálogo de abrir el archivo. 
 

 
 

 
 

En el Service Pack 2 DVD, puede encontrarse el archivo que necesita para localizar en: 
 
D:\English\WindowsServer2003R2withSP2\Enterprise\32bit\i386\ CONVLOG.EX_ 
 

 
 

Después de seleccionar el archivo, haga click en OK para cerrar el cuadro de diálogo 
Abrir archivo y, a continuación, haga click en Retry en el mensaje de Copy Error. La 
instalación se reanudará. 
 
Una vez finalizada la instalación, puede cerrar de agregar o quitar programas. En este 
punto, debe instalar el plugin Ricoh LanFax y, a continuación, volver a esta sección 
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después de configurar  Internet Information Services para permitir a DAC funcionar 
correctamente. 
 
Después de haber instalado el plugin Ricoh LanFax: 
Vamos a cambiar algunas configuraciones de IIS que permitirán a Device Viewer 
ejecutarse en un entorno de Windows 2003. 
 
Ir a Start>Administrative Tools>Internet Information Services (IIS). 
 

 
 

Amplíe la vista de árbol en el panel izquierdo bajo SystemName>Application Pools.  
Haga click derecho en DefaultAppPool y seleccione Properties 
 

 
 

En la pestaña Identity tab, seleccione la opción Predefined, y escoja Local System en el 
menú desplegable. Haga click en  OK para guardar los cambios. 
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En el panel izquierdo en el administrador de IIS, haga click en Web Service Extensions. 
Tenemos que permitir que las siguientes extensiones:  

 All Unknown ISAPI Extensions 

 Active Server Pages 

 ASP.NET v2.0.50727 

 Server Side Includes 
 

 
 

Haga click derecho en cada una de estas entradas y haga click en Allow. Si aparece una 
advertencia, ignorarla y haga click en Yes.  
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Repita estos pasos hasta que las 4 extensiones mencionadas tengan en estado Allowed, 
como se muestra a continuación. 
 

 
 

Lo último que tenemos que hacer es comprobar que la versión correcta de ASP.NET está 
siendo utilizado. 
 
En el panel izquierdo, expanda los vista de árbol Web Sites>Default Web Site.  
Haga click derecho en Device Viewer y seleccione Properties. 
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En la ventana de propiedades, vaya a la pestaña ASP.NET y cambie la versión ASP.NET a 
2.0.*. Haga click en OK para cerrar la ventana de propiedades, y ahora puede cerrar el 
Administrador de IIS. 
 

 
 

Para comprobar que los Servicios Internet Information están configurados 
correctamente, intente abrir una ventana de Internet Explorer y abra Device Viewer 
navegando a: 

http://localhost/DeviceViewer 
 

Si se presentan con la pantalla de inicio de sesión principal, han configurado 
correctamente IIS para que funcione correctamente el Device Viewer. 

 
Configuring Internet Information Services (IIS) 7 
Esta sección le guiará a través de configuración DAC/DeviceViewer con IIS 7 en un 
entorno de Windows Server 2008. 
 

1. Ir a Start>Administrative Tools>Internet Information Services (IIS) Manager. 
2. Haga click en Application Pools en el panel Connections 
 

 
3. En la lista Application, haga click derecho en DAC / DeviceViewer y haga click en 
Advanced Settings. 

http://localhost/DeviceViewer
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4. Seleccione las siguientes propiedades: 

a. .NET Framework Version = v2.0 
b. Enable 32-Bit Applications = True 
c. Managed Pipeline Mode = Classic 
d. Identity = Local System 

5. Haga click en OK para guardar los cambios. 
6. En el panel Connections, expanda Sites, expanda Default Web Site, y seleccione 
DAC/DeviceViewer. 

 

 
 

7. En el panel del centro, haga click derecho en .NET Users y haga click en Basic 
Settings. 

 

 
 
8. Haga click en Connect As… Seleccione la opción Application User (pass-through 
authentication) y haga click en OK. 
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9. Haga click en OK en la ventana Edit Application para guardar los cambios y cerrar 
la ventana. 

10. Haga doble click en Authentication en el panel central. 

 
11. Activar ASP .NET Impersonation y Windows Authentication. Para activar una 
opción, haga click en el elemento de la lista y haga clic en Enable. 

12. Haga click en DAC/DeviceViewer en el panel Connections para mostrar las 
categorías de configuración en el panel central. Haga doble click en HTTP Response 
Headers. 

 
Haga click en Set Common Headers en el panel Actions. 
 

 
 

13. Revisar la opción Expire Web content, y establecerla en 30 days. Haga click en 
OK para guardar los cambios. 

 

 
 

14. En el panel izquierdo, seleccionar su computadora. 
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15. Doble click en ISAPI and CGI Restrictions. 

 
16. Permitir los siguientes elementos en la lista: 

 Active Server Pages 
 ASP.NET v2.0.50727 

 

 
 

17. Ha terminado de configurar Internet Information Services 7. Microsoft.NET 
Framework 3.5 SP1 puede ser requerido a instalarse en el servidor.  

 
Solución de Problemas 
Q: Faxes no están llegando a la impresora LANFax. 
A: Puede que tenga que reiniciar el Servicio Ricoh Fax Service. 

1. En el Panel de Control, abra Printers and Faxes. 
2. Haga click derecho en la impresora LANFax de la cual está intentando mandar el 

fax. Haga click en Pause Printing para detener la impresora.  
3. Intente enviar otro fax a la impresora LANFax. 
4. Después de que el fax es procesado, busque en la impresora LANFax cola de 

impresión para un documento pendiente. 
Si hay un documento pendiente en la cola, reanudar la impresión y el documento 
debe ser enviado por fax satisfactoriamente. Si la cola está vacía, continúe con el 
paso 5 para hacer un ciclo del servicio de fax.  
5. Ir a Start>Run. Escriba services.msc y presione OK. 
6. Encuentre el servicio Ricoh Fax Service. 
7. Haga click derecho en el servicio y presione en Restart. Esto pondrá un ciclo en el 

servicio de fax. 
8. Puede cerrar el panel de servicios. 
9. Regrese a Printers and Faxes.  
10. Haga click derecho en la impresora LANFax que acaba de detener, y escoja 

Resume Printing. 
11. Puede cerrar la ventana Printers and Faxes. 

 
Intente enviar otro fax. Debería verlo entrar brevemente en la cola de la impresora 
LANFax antes de que sea procesado.  Si aún no funciona, asegúrese de que 
manualmente puede enviar faxes al controlador de LANFAX antes de configurar Reform 
para hacerlo. 
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Q: El estado de fax está volviendo como "no autorizado”. 
A: Esto implica que el Faxing se ha bloqueado en el MFP.  El plugin RicohLANFax permite 
enviar manualmente un UserCode al MFP que tiene acceso a la función Faxing.  Esto 
permitirá faxes a enviarse incluso si el panel fax está bloqueado en el dispositivo.  
Usando el MFP’s Web Image Monitor, User Authentication Management debe 
establecerse en “User Code” y se debe crear una entrada de la libreta de direcciones 
para el código de usuario. Una vez que han dado los pasos para crear este UserCode, un 
campo especial debe agregarse al formulario. El nombre de este campo debe ser 
“LanFaxUserCode”.  Para agregar un campo especial en el Reform Designer, primero 
abra el formulario que se utiliza para enviar faxes. A continuación, haga click en el botón 
Design/Linked Text en la barra de herramientas y seleccione Add Special Field. 
 

 
 

Haciendo click y arrastrando con el cursor del dibuje el objeto de campo en el 
formulario. 
 

 
 

En las propiedades del campo especial recién creado, cambie el Nombre a 
LanFaxUserCode e introduzca el UserCode adecuado como el valor de texto. El 
UserCode se mostrará en el objeto de campo. 
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Después de crear este objeto, intente volver a enviar el fax yendo a File>Print 
(suponiendo que tiene la secuencia de datos abierta en el formulario).  Si se ha 
configurado correctamente el UserCode en el Web Image Monitor, los faxes deben 
enviarse correctamente.  


